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Chapter 1
Overview

Welcome to the IStream Document Manager Guide for New Installations. This 
guide describes how to install and configure IStream Document Manager.

Important: This guide is for advanced users such as system administrators.

This chapter gives an overview of the installation process and describes:

• Document Conventions on page 8

• The Installation Process on page 9

• IStream Document Manager Features on page 10

• IStream Document Manager Documentation on page 16

• Contacting Oracle for Help on page 18

Note: Please read this chapter completely before beginning your installation.



OVERVIEW

8 ISTREAM DOCUMENT MANAGER VERSION 6.2 GUIDE FOR NEW INSTALLATIONS

Document Conventions

Tips, Notes, Important Notes and Warnings

Tip: A Tip provides a better way to use the software.

Note: A Note contains special information and reminders.

Important: An Important note contains significant information about the use and 
understanding of the software.

Warning: A Warning contains critical information that if ignored, may cause errors or result 
in the loss of information.

Other Document Conventions
• Microsoft Window names, buttons, tabs and other screen elements are in 

bold, for example: Click Next.

• paths, URLs and code samples are in the Courier font, for example:  
C:\Windows

• values that you need to enter or specify are indicated in the italicized 
Courier font, for example, server_name

• values that are optional are indicated with square brackets, for example 
[reserved] 
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The Installation Process

The IStream Document Manager installation process allows you to select a 
number of components (called features) to install. (IStream Document Manager 
refers to the entire family of IStream features.)

IStream Assembler is a subset of IStream Document Manager. It is for integration 
with existing customer or third-party systems, and contains no DMS.

The installation path for all IStream Document Manager components is:
C:\Program Files\Whitehill Technologies\IStream

All .EXE and .DLL files are in this location.
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IStream Document Manager Features

This section describes the various IStream Document Manager components 
(called features) that you can install.

IStream Document Manager Features
The table on the next page contains the complete list of IStream Document 
Manager features. These features are displayed in the Select Features screen 
when you run the setup application. You can install these features on more than 
one computer.

Please note:
• There are two types of features that you can select: main features and 

subfeatures. To display a subfeature, click the plus sign (+) next to the main 
feature to expand it.

• When you select a subfeature, the higher level feature is automatically 
selected.

• When you select certain subfeatures, other subfeatures may automatically be 
selected. If you later clear the subfeature that you had selected, the 
dependant subfeature that was automatically selected will remains selected.

For example, if you select the Author subfeature (under Workstation), the 
Assembler UI and the Add-in features are automatically selected, and is 
displayed with a dark gray selected check box. You cannot clear any of these 
selected checkboxes, because these features are dependant upon Author. If 
you clear the Author feature, the other features remain selected. At this 
point, you can clear the other check boxes

• For the specific software requirements and version numbers, see the IStream 
Document Manager Release Notes.
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Main Feature Subfeatures

IStream Document Manager Integration
Incorporates the IStream functionality (including 
Object Types) within the document management 
system (DMS). It is the IStream module for the 
Livelink Enterprise Server, and is therefore the 
main server for an IStream Document Manager 
installation.
For more information, see IStream Document 
Manager and Livelink Integration on page 12.

• IStream Document Manager Modules Base 
provides the base components required by IStream 
Document Manager Modules. IStream Document 
Manager enhances the base document 
management system (DMS) to provide IStream 
functionality. You need to install IStream 
Document Manager Modules separately. For 
details, please refer to Installing IStream 
Document Manager on page 27

• IStream Servlet (includes Tomcat) provides the 
connection between IStream Document Manager 
and the Assembly Server, and allows users to 
generate, regenerate and compile model 
documents

Assembly Server
• a server used to assemble and generate model 

documents
• includes the features required for remote 

generation

• Assembly Service is the document generation 
engine that assembles complex documents based 
on model documents. Includes InfoConnector.

• Proxy is a server required for rendering PDF files

Workstation
Includes the Author and Assembler user 
interfaces subfeatures. These subfeatures allows 
users to create and generate model documents and 
include the following components:
• IStream Assembler
• IStream Visualizer (Charts and Graphs)
• IStream InfoSources
• IStream InfoConnector
• standalone generator
• the plug-ins required for the authoring of model 

documents

• Author provides an authoring environment that 
uses Microsoft Word for editing and managing 
model documents. Model documents rules and 
functions are evaluated during generation to 
produce complex contracts, policies and 
correspondence.

• The Assembler UI enables local assembly of 
documents from Author. Assembler creates 
complex documents based on model documents.

• The Author Add-In for Microsoft Word enables 
you to edit and generate documents directly from 
Microsoft Word. If selected, the Assembler Add-
in is automatically selected.

• The Assembler Add-in for Microsoft Word 
enables you to generate model documents directly 
from Microsoft Word.

Note: If you select Author and Assembler UI and all 
Add-ins are automatically selected.
• Promoter is a utility which contains both promote 

and convert functions. Promoting allows you to 
easily copy documents between your many 
different physical environments. Converting 
allows you to upgrade your documents into the 
current IStream format
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IStream Document Manager and Livelink Integration
The DMS portion of IStream Document Manager allows users to manage 
documents and versions and helps users establish workflow processes.

You do not install the DMS portion of IStream Document Manager directly. 
Instead, you install the following components, one on top of the other, in this 
order:

• Livelink – a third-party base DMS from OpenText

• IStream Document Manager Module Base – integrates the IStream 
Document Manager Modules with Livelink

• IStream Document Manager Modules – provide the actual IStream 
Document Manager functionality

Note: All references in this document to Livelink refer to the DMS in IStream Document 
Manager.

Customizer
• allows users to create documents that are 

tailored (or customized) for a specific 
customer’s needs

• manages the tailored wording so that it 
continues to be applied to the document as 
benefits change and renewals occur

None

SDK
• the Software Development Kit (or Toolkit)
• allows users to integrate IStream Document 

Manager with custom applications using 
application program interfaces (APIs)

• if selected, the required IStream Document 
Manager components, SDK samples and 
documentation are automatically installed

None

Core
• provides the basic IStream Document Manager 

functionality including the support of 
InfoSources and document generation

None

Main Feature Subfeatures
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IStream Publisher
In addition to these features, IStream Document Manager can also work with 
IStream Publisher. IStream Publisher is an application where pre-defined or 
customized services are used to retrieve, assemble, render, deliver and store 
documents.

For more information about IStream Publisher, see the IStream Publisher 
documentation.
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Overview Diagram of Features
The following diagram gives a high-level overview of IStream Document 
Manager’s features.

The larger, bolded items represent features that can be assigned to a workstation 
or server during installation. These correspond to the features in the IStream 
Document Manager Features on page 10. The smaller, non-bolded items 
represent features that may be installed as part of the system’s role.

Note: This diagram does not indicate the specific applications you should install on each 
system. Some systems may be able to contain more than one feature. For further 
information, please contact Customer Support.
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Microsoft Word 2007 Document Format

By default, Microsoft Word 2007 will save to its new document format (*.docx, 
*.docm, *.dotm). This new Word format is not supported in any IStream 
Document Manager application. Therefore, you need to complete one of the 
following steps:

• under Word Options, change the default format that files are saved in to 
Word 97-2003

• change the file format to Word 97-2003 when saving a specific file
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IStream Document Manager Documentation

IStream Document Manager includes the following documents and online help 
files. If you need a copy of any of these documents, please contact your system or 
product administrator.

General Documentation
• The IStream Document Manager Release Notes include general product 

information, product enhancements and new features, supported platforms 
and third-party software, assorted considerations, and known issues and 
limitations.

• The IStream Document Manager ReadMe file describes the contents of the 
installation CD.

• The IStream Document Manager Glossary contains definitions of 
commonly used IStream terms.

User Guides and Online Help
• The IStream Assembler Online Help describes how to generate documents 

from sections and model documents.

• The IStream Assembler Add-in for Microsoft Word Online Help describes 
how to perform certain IStream Assembler functions directly within 
Microsoft Word.

• The IStream Author User Guide describes how to create, edit, and test 
sections or model documents.

• The IStream Author Add-in for Microsoft Word Online Help describes how 
to perform certain IStream Author functions directly within Microsoft Word.

• The IStream Customizer User Guide describes how to modify the content of 
generated documents so that the changes will be applied during subsequent 
document generations. 

• The IStream Document Manager DMS Guide for IStream and Model 
Documents describes how to edit and work with IStream sections and model 
documents using the DMS user interface.

• The DMS Plug-in for Author Online Help describes how to access DMS 
functionality in IStream Author.

• The IStream InfoConnector Online Help describes how to set up and 
configure IStream InfoSources.

Advanced Guides
• The IStream Document Manager Guide for New Installations explains how 

to complete a new installation of IStream Document Manager. It includes 
system requirements and detailed installation and configuration information.
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• The IStream Document Manager Message Reference Guide contains lists of 
error, log and SDK messages from the various IStream components. It is for 
technical users who need additional information about the various IStream 
messages they receive.

• The IStream Document Manager Technical Guide is for system 
administrators and technical support staff who configure IStream Document 
Manager and set up links between it and their company’s database. This 
guide is also for those who set up and maintain security groups and 
operators in the system, and who install, optimize, maintain and 
troubleshoot IStream Document Manager. It also describes installing and 
configuring IStream XML InfoSources for interactive and batch generation.

• If you have purchased the IStream Toolkit, the IStream Assembler and 
Extensibility Toolkit Guides are installed onto your system. (You can view 
these guides from the Start > All Programs > IStream menu.)

These guides contain detailed descriptions of the components in the IStream 
Toolkit, or SDK. They are for technical users who need to integrate IStream 
components with their own or other third party applications.

In addition to the toolkit guides, the IStream Toolkit SDK Samples Guide 
gives an overview of the toolkit samples. The samples are working 
examples that can help you develop custom applications.

For more information about the toolkit, see the IStream Document Manager 
Toolkit ReadMe.



OVERVIEW

18 ISTREAM DOCUMENT MANAGER VERSION 6.2 GUIDE FOR NEW INSTALLATIONS

Contacting Oracle for Help

Customer Support hours are 8:00 AM to 8:00 PM. (Eastern Time), Monday through 
Friday. Outside of these hours, send us a detailed e-mail message and you will be 
contacted during regular business hours. Please provide detailed information, as 
described in the Support Checklist.

Contact Information

Support Checklist
When contacting Customer Support, please provide the following information:

• Your name, company name, email address, and phone number

• The exact version number, including any service pack numbers of

• all your Oracle products

• your network software

• your database, including the type

• Microsoft Windows and Microsoft Word

• Microsoft .NET Framework

• your DMS (Document Management System)

• Error messages and the circumstances of their occurrence

• A full description of the problem:

• What happened? What were the sequence of events that preceded the 
problem?

• In which screen or window did the problem occur?

• Was the problem the result of pressing a key?

• Did the screen freeze? What functions of the software are affected?

• How many people are affected?

   

Mail: Oracle
145 King Street West, Suite 500
Toronto, ON  M5H 1J8 

Phone: 1-877-467-9727

Fax: 1-416-642-0315

Email: markhamsupport-skywire_ww@oracle.com

Web: www.oracle.com
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Chapter 2
Pre-Installation Procedures

This chapter describes the various procedures that you need to complete before 
actually installing IStream Document Manager.
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Stage 1: Check the System Requirements

Ensure that your system meets the software requirements described here.

Assembly Server Requirements
The Assembly Server is used for remote generation of documents. Depending on 
its use, it should be set up on a separate computer.

Before installing the Assembly Server, ensure it meets the following 
requirements:

Note: For specific versions and service pack numbers, please refer to the IStream 
Document Manager Release Notes.

Author Workstation Requirements
The Author Workstation is the computer used to create and edit model documents, 
as well as generate and test these documents. Before installing the Author 
Workstation, please ensure it meets the following software and other 
requirements:

• Microsoft Windows

• Microsoft .NET Framework 2.0 (included on the installation package)

• Internet Explorer

Operating system Microsoft Windows Server

ODBC drivers ODBC drivers for databases used by InfoSources 
during generation

Word processor Microsoft Word must be installed on the Assembly 
Server computer if Assembler will be used to create 
PDF files.
Proxy is usually installed on the same computer as 
Assembly Server. If Proxy is installed on a different 
computer, Microsoft Word must also be installed on the 
separate Proxy computer.

Java Development 
Kit

Sun Microsystems Java Development Kit (JDK).
The IStream Proxy component requires the Sun 
Microsystems JDK. Refer to Stage 3: Install the Sun 
JDK on page 24 for instructions and the supported 
version.

Livelink Application 
Programming 
Interface (LAPI) 
Version 9.7.0 for 
Windows

Open Text Livelink Application Programming 
Interface (LAPI) Version 9.7.0 for Windows
The IStreamDM InfoSource requires LAPI to access to 
the IStream Document Manager server.
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• Microsoft Word

• Livelink Application Programming Interface (LAPI) Version 9.7.0 for 
Windows

• Monitor settings: 800 x 600, 256 colors

For Microsoft Word 2007 only: Visual Studio 2005 Tools for Office – Second 
Edition Runtime (included on the installation package)

For Microsoft Word 2007 under Microsoft Windows XP: ensure you have 
enabled .NET Programmability as follows:

Select Control Panel > Add/Remove Programs > Microsoft Office 2007 > Add 
or Remove Features > Installation Options > Microsoft Office Word > .NET 
Programmability Support. 

For the specific version and service pack numbers, please refer to the IStream 
Document Manager Release Notes.

Also ensure that:
• you have TCP/IP connectivity to connect to the Assembly Server

• you have only one registered version of Microsoft Word on the Author 
Workstation; if you have more than one, or if Word is in the registry more 
than once, you may encounter problems
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IStream Document Manager Server
The IStream Document Manager server runs the Document Management System 
(DMS) server and Web server. You can run other components on this computer as 
well. Before installing IStream Document Manager Server, ensure that you meet 
the following requirements:

DMS Software Requirements

Other Server Considerations
• If the database server is on a separate computer, you need the database client 

software for that particular server installed on the IStream Document 
Manager Server.

• The client should have the same service pack as the database server.

Operating System Microsoft Windows

Database Server Microsoft SQL or Oracle
(Note: The database server should be installed on a 
separate computer)

Web Server IIS

Sun Microsystems JDK The Sun Microsystems JDK (Java Development 
Kit) must be installed and configured before 
installing IStream Document Manager. For more 
information, refer to the installation notes for the 
Sun Microsystems Java Development Kit.

FTP Site An FTP server must be set up and running on your 
IStream DMS web server. Refer to your web 
server software documentation for instructions on 
how to set up an FTP site.

Browser Internet Explorer

Intranet DMS Server Livelink DMS server

IStream Module for the 
Livelink installation 
package

Contains Livelink modules required to provide 
IStream functionality on the Livelink DMS server
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Stage 2: Obtain the Server Setup Information

Ensure that you have the following information before trying to deploy IStream 
Document Manager. This information may also be required if you need to contact 
us for help.

Operating System
• operating system name and version

• service pack number

Database Server
• Oracle or Microsoft SQL version

• database server name

• service pack number

• administrator login and password

Web Server
• web server and version

• administrator login, password and port

Browser Info
• browser name and version

IStream Server Info
• server name (for example, IStream)

• port number (for example, 2099)

• IP address

• Microsoft SQL database name or Oracle tablespace owner

• service Name (CGI - alias name)
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Stage 3: Install the Sun JDK

Before installing IStream Document Manager, ensure that the supported Sun 
Microsystems Java Development Kit (JDK) version has been installed on the 
computers where the following IStream components are to be installed:

• IStream Servlet

• IStream Proxy: a subcomponent of Assembly Server

Method: Install the Sun JDK

1. Go to the following URL:
http://java.sun.com/products/archive/j2se/1.4.2_07/
index.html

2. Download and install the Offline Installation file of Windows version of 
the JDK: j2sdk-1_4_2_07-windows-i586-p.exe

3. From the Control Panel, double click System.
4. In the System Properties dialog, click the Advanced tab.
5. Click Environment Variables.
6. Create the following new System Variables: 

7. Edit the PATH System Variable adding %JAVA_HOME%\bin; to the very 
beginning of the PATH variable. This ensures that IStream Document 
Manager will use the correct JDK version. 

8. Click OK to save your changes.

Note: You should also install any required Sun JDK DST updates.

Variable name Variable value

JAVA_HOME the JDK installation path, usually 
C:\J2sdk1.4.2_07

CLASSPATH %JAVA_HOME%\lib\tools.jar
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Stage 4: Plan for IStream Promoter

IStream Promoter is a tool that helps automate the promotion of IStream 
documents and their related sections, and Microsoft Word templates, from one 
environment (such as development, testing or production) into another.

If you will be using IStream Promoter, please ensure that:

• the user who will be using IStream Promoter has the proper permissions on 
IStream and the file system

• IStream Author and IStream InfoConnector are installed

• all remote drives are accessible and can be written to

• the account that Promoter is running for has the necessary permissions to 
write to a destination location for the promoted files

• all DMS servers are running when Promoter is started

• all necessary InfoSources have been set up: Promoter will select from a list 
of existing InfoSources when it launches. InfoSources that you create after 
Promoter starts will not appear in Promoter - you would have to restart 
Promoter to display any new InfoSources
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Chapter 3
Installing IStream Document

Manager

This chapter describes how to perform a new installation of IStream Document 
Manager.

Please note:
• For IStream Publisher installation instructions, see the IStream Publisher 

installation guides. 

• IStream Document Manager is based on Livelink. Therefore, all references 
to Livelink relate to IStream Document Manager.
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Stage 1: Install Livelink

Step A: Install Livelink
IStream Document Manager requires Livelink. For detailed installation 
instructions, refer to the installation documentation included with Livelink.

1. Install Livelink.

Note: It is assumed that you will install Livelink under the C:\OPENTEXT folder.
2. Map the URL prefixes. For details, see the Livelink First-Time Installation 

Guide.

Step B: Instal the Livelink Patches
1. Stop the DMS LiveLink server if it is running.
2. Create a C:\OPENTEXT\patch\ folder if does not already exist.
3. Install the monthly patch for Livelink. The latest supported patch is from 

October 2008.

4. Copy \patch\pat99001.txt on the IStream Module for the Livelink 
installation package to:

C:\OPENTEXT\patch\.

Step C: Install the Livelink Filter Pack (Optional)
To use the View as Web Page function, you will need to install the Livelink filter 
pack. Obtain the appropriate Livelink filter pack for Livelink 9.7.0 and install it.
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Stage 2: Install the IStream Modules and Servlet

Step A: Run Setup
1. On the Livelink Server, stop the Livelink Server service.
2. Run setup.exe from the IStream Document Manager folder on the 

IStream Document Manager installation package. The InstallShield 
Wizard screen is briefly displayed.

3. On the Installation Location screen, specify where IStream Document 
Manager will be installed.

4. To accept the default folder, click Next. To select a different folder, click 
Browse, then select the folder to install IStream Document Manager into.

5. On the Selection Features screen, select IStream Document Manager 
Integration from the feature selection panel. The IStream Document 
Manager Modules Base and IStream Document Manager Servlet 
features are automatically selected.

Note: The IStream Document Manager Servlet must be installed on the same server as 
IStream Document Manager.
6. If you have more than one Livelink installation on the system, the Select 

IStreamDM Server screen is displayed. Select the Livelink instance you 
want to use with IStream Document Manager.

7. On the Ready to Install screen, click Install to begin the installation, or 
click Back to review or change any of your installation settings.

The Setup Status screen is displayed. A status bar shows the progress of the 
installation.

When the installation is finished, the InstallShield Wizard Complete 
screen is displayed.

8. Click Finish to exit the Wizard.
9. If you are prompted to restart your computer, click Yes.
10. Start the Livelink Server service.
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Step B: Integrate IStream Document Manager Module 
with Livelink

1. Ensure the following services are started:

• Livelink Admin

• Livelink Server
2. Copy \calligo_6_2_0\ and its subfolders from the IStream Module for 

Livelink installation package to:
c:\opentext\staging

3. Open the Livelink Administration page.
http://server_name/service_name/livelink.exe?func= 
admin.index

4. Enter the Administrator password, then login.
5. Scroll down to the Module Administration section. In this section, click 

Install Modules.
6. Scroll to the Installable Modules and select the Calligo 6.2 check box.
7. Click Install.
8. Enter the Admin User Password and click Log-in.
9. Wait until you see a message appears stating that you need to restart the 

Livelink server before continuing.
10. Open the Services dialog from the Control Panel.
11. Stop the Livelink Server service, and then restart it.
12. In the Livelink Administration page, click Continue.

The IStream Document Manager module is included in the Installed 
Modules list.

13. From the Livelink Administration page, select Configure IStream DM 
Parameters.

14. Select the IStream DM Explorer check box, then click Update.
15. Restart the Livelink Server service.
16. Click Continue.

You are returned to the LiveLink Administration page. Close your web 
browser.

Step C: Check Opentext.ini Settings

Security Settings
Ensure that the following lines are in the[Security]section of 
C:\OPENTEXT\config\opentext.ini, with these settings:
cookieUserPWD=true

cookieClientIPAddress=8
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Warning: Do not use the Livelink administration page to change the cookieClient 
IPAddress.

Step D: Customize the Livelink Database
Complete this step to customize the required tables in the Livelink database.

In this procedure you run an application (tnginfo.install)that updates 
certain database tables.

1. Backup your Livelink database.
2. Log in to the DMS.
3. In your web browser, go to:

http://server_name/service_name/livelink.exe? 
func=tnginfo.install

4. Login to IStream Document Manager if necessary using the Admin account.

The tnginfo.install application runs.
5. Important: When prompted, restart the Livelink Server service.
6. Click Update Database Records.

The system updates certain IStream Document Manager-specific document 
database records.

7. The final screen lists the items that have been updated.
8. When the update has completed, click OK, then close the web browser.
9. Important: Stop and restart the Livelink Server service. This is a critical 

step.

Step E: Configure the IStream Servlet
The IStream Servlet provides the connection between IStream Document 
Manager and the Assembly Server. Complete the following procedure to 
configure the IStream Servlet on a supported Windows system.

Method: Configure the IStream Servlet

1. Start the Apache Tomcat service.
2. Wait until the following calligo subfolder is created:

install_folder\3rd Party Components\tomcat\webapps\ 
calligo\

Note: This can take up to two minutes
3. Stop the Apache Tomcat service.
4. If you are using IStream Publisher:

a. Open the following file:
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install_folder\3rd Party Components\tomcat\ 
webapps\calligo\conf\CalligoServlet.configure

b. Set the mode parameter to edelivery.

c. Save and close the configuration file.

d. Copy and replace the following jar files from any MQ client installation 
of your WebSphere MQ Server:
• connector.jar

• com.ibm.mq.jar

• com.ibm.mqjms.jar

• dhbcore.jar

• jms.jar

• jta.jar

to:
\install folder\3rd Party Components\

tomcat\webapps\calligo\WEB-INF\lib\

Note:

• You need to ensure that the MQ client version matches the MQ 
server version.

• The default MQ client installation folder is:
C:\Program Files\IBM\WebSphere MQ\Java\lib

This is an important step because these .jar files are no longer 
bundled with the installation package.

e. To configure IStream Proxy to work with IStream Servlet:

Copy \lib\lapi.jar from any LAPI Version 9.7.0 client installation 
to:
\install folder\Components\WEB-INF\lib

The default LAPI client installation folder is:
C:\Program Files\Open Text\LAPI

5. In the same folder as in the previous step, open 
InteractiveServlet.configure

6. Configure the parameters in this file: for details, see 
InteractiveServlet.configure on page 74 of the IStream Document Manager 
Technical Guide.

7. Save and close the configuration file.

In the same folder as in the previous step, open 
NonInteractiveServlet.configure

8. Locate the CalligoRMI.server.hostname parameter and set it to the 
name of the server on which the IStream Proxy server is to run.
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9. If you are using IStream Publisher, you also need to configure the other 
parameters in this file: for details, see NonInteractiveServlet.configure on 
page 76 of the IStream Document Manager Technical Guide.

10. Save and close the configuration file.
11. Set the Startup type for the Apache Tomcat service to Automatic in the 

Services Control Panel.
12. Start the Apache Tomcat service.

Configuration of the Servlet is complete.

Step F: Change the Port Number
If you:

• install IStream Server and IStream Assembler on an Oracle system where 
Tomcat is not integrated with IIS, then

• configure the Assembly Server and try to generate from IStream Document 
Manager

this may create a port conflict.

To resolve this, you need to change the port number from 8080 to 24000 in two 
locations:

1. In the C:\OPENTEXT\config\opentext.ini file, change the following 
line: Calligo_locServlet=:8080/calligo

to:

Calligo_locServlet=:24000/calligo
2. Change the port in install_folder\3rd Party 

Components\tomcat\conf\server.xml from 8080 to 24000.
3. Restart the Tomcat and Livelink Server services.
4. Restart the IStream Proxy server.

Step G: Hide Specific Livelink Modules
IStream Document Manager supports only certain Livelink functions. 
Specifically, the My Home and Java modules are not supported. We therefore 
recommend to hide these modules:

1. From the IStream Document Manager Administration page, click 
Administer Java Module.

2. Clear the Configured check box beside Application Server.
3. Submit the page then restart Livelink Server when prompted.

The My Home links are now hidden from the Enterprise Workspace.
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Step H: Configure Searchable Types
Complete the following procedure to add the required IStream document types to 
the searchable file types

1. From the Livelink Administration page, in the Search Administration 
section, click Configure Search Options.

2. In the Full Text section, in the Options section, click Configure next to the 
Searchable Types component.

The Searchable Types screen opens.

3. Scroll down the page until you see the green button  that is just below the 
Available box in the Menu Items section.

4. Click the green button .
5. In the Edit section, enter the following values:

• Label: IStream Document

• Image: /calligo/calligodocnewdoc.gif

• Indent: 1

• Query:
OTSubType:7771 and (OTFilterMIMEType: qlrange "msword|pdf")

6. Click the green button  again.

The menu item is added to the Available list. You can now enter the second 
type.

7. In the Edit section, enter the following values:

• Label: IStream Section

• Image: /calligo/calligotemplatenewdoc.gif

• Indent: 1

• Query: OTSubType:7772 and OTFilterMIMEType:msword

8. Click the yellow right arrow  to move the newly created items from the 
Available list to the Displayed list.

9. Use the yellow up and down buttons  that are to the right of the Displayed 
list to move the new items.
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10. Click Submit to save your changes.

Step I: Configure DMS for Zip & Download and Print 
Features

Complete the following procedures to enable the Zip & Download and Print 
features in the DMS for IStream documents.

Part 1: Enable Features in the Livelink Administration Page
1. From the Livelink Administration page, scroll to the Multi-File Output 

Administration section.
2. Complete one or both of the following steps, depending on which features 

you want to enable:

To enable the Zip & Download feature:

a. Click Download Settings.

b. Select the check boxes for all IStream document types:

c. Click Submit.

d. Restart LiveLink service.

To enable the Print feature:

• Complete the previous steps, but in step 2 a., select Print Settings 
instead of Download Settings.

Part 2: Apply the Open Text Patch File
1. Stop the DMS LiveLink server if it is running.
2. Create a C:\OPENTEXT\patch\ folder if does not already exist.
3. Copy \patch\pat99005.txt on the IStream Module for Livelink 

installation package to:

C:\OPENTEXT\patch\
4. Restart the LiveLink service.

Step J: Configure Security Permissions (Optional)
You can configure the Assembly Server service as either a Local System account, 
or as a specific account.
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If you will be using Assembly Server in a Directory Services environment, you 
cannot run it under a Local System account. You must run it under a different user 
account as described in  Method: Create a User Account for Livelink 
Authentication on page 52. This ensures that the Directory Services authentication 
will succeed.

If you can connect to the Assembly Server and generate documents from it using a 
Local System account, but cannot connect and generate using your specified 
account, you may need to configure the COM security permissions for the user 
account you have set up.

Method: Configure security permissions (Windows 2003 Server)

1. Select Start > Run and enter dcomcnfg.exe.

The Component Services window opens.
2. Navigate to Component Services > Computer > My Computer > DCOM 

Config > iaegensm
3. Right-click iaegensm and choose Properties.

The iaegensm properties dialog opens.
4. Click the Security tab.
5. Under Launch and Activation Permissions, click Customize, Edit, and 

add the user account you created for Livelink Authentication.
6. Under Access Permissions, click Customize, Edit, and add the user 

account you created for Livelink Authentication.

Step K: Integrate Tomcat with IIS (Optional)
You should integrate the Microsoft Internet Information Server (IIS) and Java 
Servlet Engine (Tomcat) on the IStream Server in order to complete any of the 
following tasks:

• configure a firewall for the web server

• use SSL to secure your web server

• load balance the IStream server

Method: Integrate Tomcat with IIS

1. Switch to run WWW service in IIS 5 isolation mode:

a. Start the IIS management console.

b. Choose the Web Sites container.

c. Right-click the container and select Properties, then select the Service 
tab.

d. Select Run WWW service in IIS 5.0 isolation mode.
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e. Click Apply.
2. Using the Internet Information Services Manager, add a new virtual 

directory to your IIS web site:

a. Right-click the Default Web Site item

b. Selecting New >Virtual Directory.

c. The Virtual Directory Creation Wizard starts.

d. In the Alias field, enter calligo_servlet. 

e. In the Directory field, enter the physical path of this virtual directory. 
This is the directory that contains the file isapi_redirector2.dll:
install_folder\3rd Party Components\tomcat\bin\i386

f. Assign the virtual directory Execute access permission.
3. Using the IIS management console, add isapi_redirector2.dll as a 

filter in your IIS web site:

a. Right-click the Default Web Site item and select Properties.

b. In the Default Web Site Properties dialog box, select the ISAPI 
Filters tab.

c. Click Add to add a new filter with the following information:

• a name of calligo_servlet 

• the filter of the executable must be:
install_folder\3rd Party Components\tomcat\bin\ 
i386\isapi_redirector2.dll

4. Update the following entry in C:\OPENTEXT\config\opentext.ini 
Calligo_locServlet=/calligo

5. Restart the Livelink Server service.
6. Back up the Tomcat server configuration file:

install_folder\3rd Party Components\tomcat\conf\ 
server.xml

7. In this same folder, delete server.xml, then rename server_int_iis.xml 
to server.xml.

8. Restart the Tomcat service.
9. Restart IIS by stopping and starting the IIS Admin service.
10. Open the Internet Information Services Manager.
11. In the Default Website Properties dialog box of the IIS service, select the 

ISAPI Filters tab.
12. Confirm that a green arrow appears in the Status column of the 

calligo_servlet filter. 

If this arrow does not appear, you can still continue this procedure, but need 
to check for this arrow again after the final step, when you test the 
integration.
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13. From the IIS management console, select Web Service Extensions.
14. Click Add a New Web Service Extension.
15. Enter an extension name, for example, Tomcat.
16. Add the following file as a required file:

install_folder\3rd Party Components\tomcat\ 
bin\i386\isapi_redirector2.dll

17. Choose to allow the required file.
18. To test the integration, in your web browser, log on to: 

http://localhost/calligo/test.do

Note: If SSL is enabled, enter https in the web address, instead of http.

A message like this should display:
Assembly Server Servlet Test succeeded on Wed Aug 11 
15:43:53 EST 2008

19. If the green arrow did not appear in the Status column of the 
calligo_servlet filter (as described in steps 10 to 12), then repeat steps 
10 to 12, and then check the status again.

Start the ITLogServer service if it is not already started.
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Stage 3: Install Assembly Server

Step A: Run Setup
1. Ensure that the Sun JDK is installed. For instructions, see  Stage 3: Install 

the Sun JDK on page 24.
2. Run the IStream Document Manager setup program.
3. Select the IStream Assembly Server feature. The IStream Assembly 

Service and Proxy features will be automatically selected.
4. Select the date format you want to use for the IStream Document Manager 

CTOD function. (For more information, see CTOD on page 97 of the 
IStream Author User Guide.)

• MM/DD/YYYY (month, day, year)

• DD/MM/YYYY (day, month, year)

Note:

• The date settings you choose will overwrite the previous date settings.

• You should use a consistent date format in all deployments.
5. If you are using an IStreamDM InfoSource to access documents in the 

DMS, enter the following information:

• Server – the name of the IStream Document Manager database server in 
the field.

• Connection - 

• for SQL databases: enter the name of the database where the 
Livelink database tables were installed

• for Oracle databases: enter the name of the Oracle user that owns 
the database tables

You can change this information later by editing the IStreamDM InfoSource 
using the IStream InfoConnector.

6. If you are asked if you want generated IStream documents with tags to be 
QuickGen ready, you should select Yes. If you select No, documents will 
have to be regenerated in IStream Customizer before you can use the 
QuickGen feature.

For more information about the QuickGen feature, see QuickGen on page 73 
of the IStream Customizer User Guide.

7. Complete the installation wizard.
8. Copy all files in \bin from any LAPI Version 9.7.0 client installation to:

\install folder\Components\

9. Start the following services:

• IStream Assembly Server

• IStreamDM Proxy
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• ITLogServer

Important: Please note the following important information if you are generating PDFs 
remotely:

• After installing Assembly Server on a computer with Microsoft Word, 
remote PDF generation will fail unless Microsoft Word is started and the 
license agreement is accepted.

• If IStream Proxy is installed with Microsoft Word 2003 SP2, and you are 
using remote PDF generation, you will need to change the IStream Proxy 
service to run under an Administrator account. Note that you will have to 
change the password that the IStream Proxy service uses if the 
Administrator’s password is changed. 

Step B: Configure IStream Document Manager for the 
Assembly Server

Note: Complete this step only if you are using IStream Document Manager with 
Assembly Server.

This following procedure describes how to configure IStream Document Manager 
to work with the Assembly Server. You need to create an Environment to store a 
single Assembly Server Environment object. This object indicates to Tomcat 
where the Assembly Server is located, its port and proxy information.

1. Ensure the following services are started:

• IStream Assembly Server

• Livelink Admin

• Livelink Server
2. In your browser, go to http://server_name/service_name/

livelink.exe

3. Log on as an administrator.
4. In the Enterprise Workspace, click the Add Item drop-down box and 

select Environment.
5. In the Add:Environment page, enter a descriptive name, for example 

Assembly Server Environment, then click Add.
6. In the Enterprise Workspace, click your newly created environment link.

The environment page opens.
7. Click the Add Item drop-down box and select Assembly Server.
8. In the Add:Assembly Server page, enter a descriptive name, for example 

DefaultServer.
9. Click Add.

In the Assembly Server Environment, the new item is listed.
10. Click the Functions button, then select Properties and then select Specific.
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11. In the Specific info page, enter the following information:

• Host Address - the server running the Assembly Server 

• Port number - the port of the Assembly Server - this is usually 4300

• Enabled - When selected, the Assembly Server is enabled. Ensure that 
only one Assembly Server is enabled. For any others, this field must be 
cleared.

• Proxy User and Proxy Password - These fields are used when 
retrieving data from a database during document generation.

12. Click Update.
13. Restart the Tomcat service.

The Assembly Server Service is configured.

Step C: Check the Printer Ports

Ensure that all printers each have their own unique port. The IStream PDF 
converter might use the same port as another printer. If so, assign it to another 
port.



INSTALLING ISTREAM DOCUMENT MANAGER

42 ISTREAM DOCUMENT MANAGER VERSION 6.2 GUIDE FOR NEW INSTALLATIONS

Stage 4: Install the Author Workstation

Step A: Run Setup
1. Run the setup application on the client workstation.

2. Select the Workstation feature. Other features will be automatically 
selected.

3. Optionally select the Customizer and SDK features.
4. Select the date format you want to use for the IStream Document Manager 

CTOD function. (For more information, see CTOD on page 97 of the 
IStream Author User Guide.)

• MM/DD/YYYY (month, day, year)

• DD/MM/YYYY (day, month, year)

Note:

• The date settings you choose will overwrite the previous date settings.

• You should use a consistent date format in all deployments.
5. If you are using an IStreamDM InfoSource, enter the Server and 

Connection names. (You can change this information later by editing the 
IStreamDM InfoSource using IStream InfoConnector.)

6. If you are asked if you want generated IStream documents with tags to be 
QuickGen ready, you should select Yes. If you select No, documents will 
have to be regenerated in IStream Customizer before you can use the 
QuickGen feature.

For more information about the QuickGen feature, see QuickGen on page 73 
of the IStream Customizer User Guide.

7. Complete the installation wizard.
8. Copy all files in \bin from any LAPI Version 9.7.0 client installation to:

\install folder\Components\

Step B: Configure Author Custom Settings (Optional)
An administrator can set up all IStream Author workstations to use the same 
default customized settings. These settings are:

• PDF bookmark and hyperlinks 

• IStream Visualizer (charts and graphs)
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Method: Apply the same customized settings to all IStream Author 
workstations

Warning: This procedure involves editing the Windows registry editor and is therefore for 
system administrators only. We strongly recommend that you back up your 
registry before proceeding.

1. On the IStream Author system, enter the default PDF and IStream Visualizer 
settings if you have not already done so. For details, see the IStream 
Document Manager Author User Guide.

2. On the IStream Author system with the default PDF and IStream Visualizer 
settings, export the following registry keys:
HKEY_CURRENT_USER\Software\Whitehill 
Technologies\authorm\1.0\style_profiles

HKEY_CURRENT_USER\Software\Whitehill 
Technologies\IStream Components\GraphsAndCharts

3. On each of the other IStream Author workstations, import these registry 
keys.

4. In the registry editor, verify that the settings have been imported.

Step C: Delete Custom Default Visualizer Settings 
(optional)

If IStream Author is reinstalled on the same computer, any changes that were 
made to the IStream Visualizer (charts and graphs) settings will be retained.

To discard the customized settings and replace them with the default settings, you 
must delete the following registry key:
HKEY_CURRENT_USER\Software\Whitehill Technologies\ 
Components\GraphsAndCharts

Step D: Check the Printer Ports
Ensure that all printers each have their own unique port. The IStream PDF 
converter might use the same port as another printer. If so, assign it to another 
port.

Step E: Exclude Folders from Anti-Virus Scans
To avoid conflicts with IStream Document Manager, configure your anti-virus 
application so that it will not scan the IStream Document Manager installation and 
DMS folders and subfolders.
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Stage 5: Configure InfoSources

1. Make a list of your data sources and locations.
2. After installing Author Workstation and Assembly Server, launch 

InfoConnector.
3. The first time InfoConnector launches, it uses the installed local.idb. All 

information about the InfoSource’s configuration is stored in this file, 
normally located in:
install_folder\Components\Shared

4. Assembly Server requires InfoSources for certain generation processes. The 
IStream Document Manager installation process creates and sets up the 
following required InfoSources:

Note:  ODBC DSNs must be System DSNs, not User DSNs.

5. Configure any additional InfoSources you plan to use for document 
generation.

Important: You cannot use mapped drives for InfoSources and model documents. Use UNC 
paths instead.
6. If you change the InfoSources, you will be prompted to restart the Assembly 

Server service. 

Name Type Description Configuration Details

system
(IStream 
InfoSource)

ODBC IStream Document Manager 
system tables, System InfoSource

Data Source: System
Application: None

IStreamDM
(IStream 
InfoSource)

IStreamDM the root of IStreamDM; a pre-
installed InfoSource

The Server Name, Port and 
Location should be set according 
to the installation of DMS server. 
Do not change the Location 
because this will cause web 
generation from the DMS to fail.
Note: This InfoSource is available 
only if you have an IStream DMS 
license. Otherwise, the IStream 
File System (listed next) will be 
used.

IStreamFS File System the default, pre-installed IStream 
Document Manager file system 
InfoSource

Location:
[IStream Document Manager 
install 
folder]\IStreamDocuments

DynaFS (Internal use 
only)

used by IStream Document Manager for internal purposes 
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For more information, refer to the InfoConnector Online Help.
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Stage 6: Install the Required Communicator & 
Publisher Patches

If you have any of the following products, you will need to install their respective 
patches:

• IStream Communicator

• IStream Publisher

Please contact customer support to get the latest patches for these products.

Please also see the IStream Document Manager Release Notes for the currently 
supported versions of these products.
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Stage 7: Install Livelink Explorer

Note: Complete this stage only if you have purchased the IStream Document Manager 
Plug-Ins.

Refer to the Livelink documentation installation guides for the Livelink Explorer 
installation requirements.

To use Livelink Explorer, you need to install it on the Livelink DMS. This 
requires certain steps in addition to the standard Livelink Explorer installation 
procedure:

Method: Install Livelink Explorer on IStream Document Manager

1. Install Livelink Explorer 4.8.1 from OpenText. For details, see the Livelink 
Installation documentation.

2. When the installation is complete, copy the contents of the following folder 
from the IStream Module for Livelink installation package:
\webexp_4_8_1\

to:
Livelink_folder\staging\webexp_4_8_1

Important: Ensure that you copy the contents of this folder (webexp_4_8_1), and not the 
actual folder itself.

3. Copy pat99002.txt from the installation package to 
C:\OPENTEXT\patch\. 

4. Open the Livelink Administration page:
http://server_name/service_name/livelink.exe?func= 
admin.index

5. Install the Livelink Explorer Professional, Standard and Download 
modules from the available modules list. Refer to the Livelink First-Time 
Installation Guide for details.

6. From the Administration > Configure IStream DM Parameters section, 
ensure that the IStream DM Explorer check box is selected. (For 
information about these parameters, see Configuring IStream Document 
Manager Parameters on page 46 of the IStream Document Manager 
Technical Guide.)

7. Restart Livelink.

Note: You should perform the remaining steps on the client’s system if you want 
Livelink Explorer client installed on this system. If you complete these steps on 
the IStream Document Manager system, Livelink Explorer will be installed on the 
Livelink DMS server.
8. In Internet Explorer, from the Enterprise menu, select Livelink Explorer.
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9. Select Yes when prompted to download and install the Livelink Explorer 
client.

The Livelink Explorer client installs.
10. In the Livelink Explorer Professional - Custom Setup dialog box, expand 

the Windows Explorer Integration feature. 

The Microsoft Word Integration is displayed just below the Windows 
Explorer Integration feature.

11. Click Microsoft Word Integration, then select This feature will not be 
available.

A red ‘X’ should now appear next to the Microsoft Word Integration 
feature, indicating it is no longer selected.

Click Next to continue and complete the Livelink installation.
12. Double-click the Livelink Explorer shortcut on your desktop.

You will be prompted to configure the Explorer connection with the DMS. 
Configure the connection.

13. You will be prompted to configure your Livelink Explorer client to connect 
to your DMS.

Enter the machine name and URL for the system on which the DMS with 
the installed Explorer module is running.
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Stage 8: Install Livelink Directory Services

Note: Complete this stage only if you have purchased the IStream Document Manager 
Plug-Ins.

Not all modules and platforms supported by Livelink Directory Services are 
supported in IStream Document Manager.

If you will be using Livelink Directory Services in your DMS, you will need IIS 
running on Windows.

Windows 2003 Server is the supported platform for IStream Document Manager. 
Because Windows 2003 uses NTLM Authentication, LDAP Authentication is not 
available for IStream Document Manager.

Step A: Install Livelink Directory Services
The following procedure gives an overview of how to install Livelink Directory 
Services. For more information, see the Livelink Directory Services Installation 
and Administration Guide.

1. Open the Services control panel and stop all Livelink services.
2. Follow the prompts to install Livelink Directory Services 

LLDIRSRV_234_Win.exe.
3. When the Directory Services installation is complete, open the Services 

control panel and restart all Livelink services.
4. In the Livelink Administration Page, click Continue and scroll down to 

Directory Services Administration. 
5. Click Choose Directory Services for NTLM Synchronization options and 

set the options as follows:

NTLM Synchronization:

a. Set Authentication to NTLM Authentication (Username only). 

b. Set Synchronization to NTLM Synchronization.

c. Set Livelink CGI Hosts to:

<Livelink address>,127.0.0.1. 

where Livelink address is the IP address of the computer that runs the 
IIS server and Livelink CGI (the Livelink application).

Example: 192.168.0.12,127.0.0.1
For details, refer to Enabling the Synchronization Feature in the Livelink 
Directory Services Installation and Administrator’s Guide.

6. In the Livelink Administration Page, click Continue and scroll down to 
Password Generation Policy. Set the options as follows:

• select the Hidden option

• select the Lowercase option
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• ensure that Domain and name is not selected

For details, refer to Password Generation Options in the NTLM 
Synchronization section of the Livelink Directory Services Installation and 
Administrator’s Guide.

7. After installing Livelink Directory Services, assign permissions to user 
groups so that users will have proper access to DMS documents.

Step B: Integrate Tomcat with IIS (Optional)
After installing Livelink Directory Services, you should integrate Tomcat with 
IIS.

Method: Integrate Tomcat with IIS

1. Switch to run WWW service in IIS 5 isolation mode:

a. Start the IIS management console.

b. Choose the Web Sites container.

c. Right-click the container and select Properties, then select the Service 
tab.

d. Select Run WWW service in IIS 5.0 isolation mode.

e. Click Apply.

2. Using the Internet Information Services Manager, add a new virtual 
directory to your IIS web site:

a. Right-click the Default Web Site item

b. Selecting New >Virtual Directory.

c. The Virtual Directory Creation Wizard starts.

d. In the Alias field, enter calligo_servlet. 

e. In the Directory field, enter the physical path of this virtual directory. 
This is the directory that contains the file isapi_redirector2.dll:
install_folder\3rd Party Components\tomcat\bin\i386

f. Assign the virtual directory Execute access permission.
3. Using the IIS management console, add isapi_redirector2.dll as a 

filter in your IIS web site:

a. Right-click the Default Web Site item and select Properties.

b. In the Default Web Site Properties dialog box, select the ISAPI 
Filters tab.

c. Click Add to add a new filter with the following information:

• a name of calligo_servlet 

• the filter of the executable must be:
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install_folder\3rd Party Components\tomcat\bin\ 
i386\isapi_redirector2.dll

4. Update the following entry in C:\OPENTEXT\config\opentext.ini 
Calligo_locServlet=/calligo

5. Restart the Livelink Server service.
6. Back up the Tomcat server configuration file:

install_folder\3rd Party Components\tomcat\conf\ 
server.xml

7. In this same folder, delete server.xml, then rename server_int_iis.xml 
to server.xml.

8. Restart the Tomcat service.
9. Restart IIS by stopping and starting the IIS Admin service.
10. Open the Internet Information Services Manager.
11. In the Default Website Properties dialog box of the IIS service, select the 

ISAPI Filters tab.
12. Confirm that a green arrow appears in the Status column of the 

calligo_servlet filter. 

If this arrow does not appear, you can still continue this procedure, but need 
to check for this arrow again after the final step, when you test the 
integration.

13. From the IIS management console, select Web Service Extensions.
14. Click Add a New Web Service Extension.
15. Enter an extension name, for example, Tomcat.
16. Add the following file as a required file:

install_folder\3rd Party Components\tomcat\ 
bin\i386\isapi_redirector2.dll

17. Choose to allow the required file.
18. To test the integration, in your web browser, log on to: 

http://localhost/calligo/test.do

Note: If SSL is enabled, enter https in the web address, instead of http.

A message like this should display:
Assembly Server Servlet Test succeeded on Wed Aug 11 
15:43:53 EST 2008

19. If the green arrow did not appear in the Status column of the 
calligo_servlet filter (as described in steps 10 to 12), then repeat steps 
10 to 12, and then check the status again.

Start the ITLogServer service if it is not already started.
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Method: Create a User Account for Livelink Authentication

1. Add the following line to the [options] section of 
C:\OPENTEXT\config\opentext.ini:
Calligo_AllowTunneling=TRUE

2. Restart the Livelink Server service.
3. Create a new Windows user account. This is a special user account that only 

Assembly Server and IStream Document Manager Proxy Services will use 
for Livelink authentication.

Important: For the user name, use only lowercase alphanumeric characters and no special 
characters, for example: livelink.
4. Important: Add this user account to the Windows Administrators group, 

and also to the group that synchronizes with Directory Services.
5. In the Directory Services Administration section, select the Configure 

Synchronization Sources item.
6. Click the Synchronize now button to synchronize the Directory Services.
7. Important: Go to the Users & Group DMS administration page and give 

the user account you created system administration rights.
8. Configure IStream Document Manager Proxy and Assembly Server services 

to run under the user account you have just set up. If you run services as a 
Local System account, Directory Services will not be able to authenticate it.

9. Restart the IStream Document Manager Proxy and Assembly Server 
services.
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Stage 9: Disable Advanced Versioning

IStream Document Manager does not support the Livelink advanced versioning 
feature. You therefore need to disable this feature as follows:

1. In your browser, login to IStream Document Manager as an administrator.
2. In the System Administration Section, click Administer Item Control.
3. Clear the Enable advanced major/minor versioning for Documents in 

the system check box.
4. Click Save Changes
5. Restart the Livelink Server service when prompted.
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Stage 10: Test the Installation

After you have installed the IStream Document Manager components, you should 
test your installation and set up your users and groups. For testing, begin with the 
default users and groups that are installed with IStream Document Manager.

Step A: Create a Test User
The first step in testing is to create a test user.

Method: Create a test user

1. In your browser, login to IStream Document Manager as an administrator.
2. In the Enterprise Workspace, from the Enterprise menu, select Users & 

Groups.
3. Click Add User.
4. In the Add New User page, enter testuser as the login name.
5. Select DefaultGroup from the Department drop-down list.
6. Enter and verify a password. Ensure that the user has the rights to add and 

update permissions.
7. Ensure Log-in enable is selected.
8. Click Submit.

The Users and Groups page opens.
9. From the Enterprise menu, select Workspace.
10. You must now set up testuser with write-access to the Enterprise 

Workspace: continue to the following procedure.

Step B: Configure the Test User
After setting up the test user, you need to configure it so that it has write-access to 
the Enterprise Workspace.

Method: Set up the test user for write access

1. In the Enterprise Workspace, click the Functions drop-down list for the 
Enterprise workspace.

2. From the Functions menu, select Permissions.
3. On the Permissions page, in the Access List, click the Grant Access 

button.
4. In the Find drop-down box, select User Log-in.
5. Enter testuser in the For text field and click Find.
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The user name (testuser) is listed.
6. Click the Grant Access check box, then click Submit.
7. On the Edit User Permission page, select all the permissions for 

testuser.
8. In the Apply to drop-down list, select This Item & Sub-Items.
9. Click Update. A progress indicator displays.
10. When the Status field indicates that the process is finished, click OK.
11. Click Done in the left frame of the Permissions page.

You can now begin testing the IStream Document Manager components 
using the test user.

Step C: Test IStream Document Manager
Before testing other components of IStream Document Manager, you should first 
test the IStream Server.

Method: Test IStream Document Manager 

1. In your browser, log in to IStream Document Manager as testuser: see  
Step A: Create a Test User on page 54.

2. In the Enterprise Workspace, click Add Folder.

3. In the Add:Folder page, name your folder testfolder and click Add.

Your new folder, testfolder, is included in the list of items in the 
Enterprise Workspace.

4. Click testfolder to ensure that you can access this folder. If you can 
access testfolder, IStream Document Manager is working. You can now 
test the other IStream Document Manager components.

Step D: Test IStream Author
Before testing the Author Workstation, confirm that your InfoSources are 
configured, and that the userinfo and serverinfo are set in Author and 
Assembler.

Method: Test IStream Author

This procedure explains how to author a model document and save it.

1. Open Author.

Note: If you are using Proxy IDs, ensure they are set up correctly. For details, see  Step 
B: Assign Proxy User IDs on page 59.
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2. The first time you open Author, you are prompted to enter your User ID and 
Password. Enter the testuser ID and password: see  Step A: Create a Test 
User on page 54.

3. To set up the repository, from the Author menu, click Options.
4. Click Browse.
5. Select a repository then click OK.
6. In the Options window, click OK.
7. From the File menu, select New Model Document.
8. Enter testmodel as the master section name: this is also the name for the 

model document.
9. Verify that the repository is selected and click OK.
10. Enter a simple rule in the master section of your model document such as:

TEXT

This is a test model document

ENDTEXT

11. Click the Save button to save the model document.
12. Click Yes to compile the section as it saves.
13. Name the model document testmodel. Keep the name the same as the 

master section name.
14. Click Save.
15. To test the generation in Author, click the Author drop-down list, then 

Generate.

This should produce a new IStream document from your model and display 
it in Microsoft Word.

16. Close Microsoft Word (without saving your changes) and then close Author.

You can now set the permissions for the model document if the document is 
stored in IStream Document Manager. You can also test the generation of a 
model document. 
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Stage 11: Configure and Test Models

Step A: Set the Model Permissions
Before a model document can be generated, permissions must be given to users if 
the document is stored in IStream Document Manager.

The following procedure explains how to give the test user permissions to 
generate the model document:

Method: Set model document generation permissions

1. In your browser, login to IStream Document Manager with the testuser 
ID: see  Step A: Create a Test User on page 1.

2. From the Function drop-down list, choose Permissions for the testmodel 
model document.

3. Click testuser in the left frame.
4. Select the Generate From Model permission check box, then click Update.
5. Click Done in the left pane.

The permissions are set for testuser to generate the model document from 
IStream Document Manager.

Step B: Configure and Test Generation
Once a model document is created and permissions are given to the user, you can 
generate the model document: see  Step D: Test IStream Author on page 2 and  
Step A: Set the Model Permissions on page 57.

Method: Configure and Test Generation

1. Ensure that the Assembly Server service is started.
2. If you are not already logged in, login to IStream Document Manager using 

the testuser ID and password: see  Step A: Create a Test User on page 1.
3. Click Add IStream Document.
4. Enter TestCalligoDocument as the document name.
5. From the Select Model drop-down list, select testmodel, which is the 

model created in Author: (see  Step D: Test IStream Author on page 2).
6. Click Add. The document generates.
7. When it has completed, click OK.
8. Locate and open the TestCalligoDocument to view the generated 

document in HTML format.
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The installation of IStream Document Manager is now complete. The next, final 
stage describes how to design your users and groups.

 



STAGE 12: MANAGE USERS AND GROUPS 

ISTREAM DOCUMENT MANAGER VERSION 6.2 GUIDE FOR NEW INSTALLATIONS  59

Stage 12: Manage Users and Groups

Once the IStream Document Manager installation is complete, you can design the 
structure of your users and groups, create base groups and create larger groups out 
of smaller groups. You need to decide who should have the ability to create and 
edit users, and what the audit options should be and then set them.

Step A: Manage User Log-ins and Permissions
During the installation of IStream Document Manager, there are a number of user 
log-ins and permissions that must be managed.

During the initial configuration, log in everywhere using the admin user ID 
(Windows, SQL Server, IStream Document Manager). You may use a different 
log in at run time, but this log in must have access to the databases, network 
resources and any local files that will be used by IStream Document Manager.

Step B: Assign Proxy User IDs
IStream Document Manager uses the proxy user ID to access information in 
databases. You can assign a proxy user ID to groups of users or to individual 
users. If you do not indicate a proxy user ID for a particular user or group, then 
IStream Document Manager uses the login user ID. 

Tip: For additional information about proxy users, see the IStream Document Manager 
Technical Guide. 

Each proxy user ID must have a valid Windows user ID for the domain and must 
also be set up as a valid user of each database. If proxy users are not used, then the 

Component Item

Microsoft Windows login ID and password for the administrator

SQL Server/Oracle system administrator login ID and password

IStream Document 
Manager

administrator login ID and password

List of IStream Document 
Manager Users

• login IDs
• passwords
• assigned Assembly Server

Assembly Server Service login accounts under which the Assembly Server 
service will run

Proxy Users a proxy User ID and Password for each group and/
or user under an Assembly Server

Folder Permissions choose groups and users which have permissions 
in each folder for adding, deleting, and so on

Model Documents choose groups and users that have permission to 
generate from each model document
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ID of each user with permission to generate documents must be set up as a valid 
user of each database. If a proxy user is set up in IStream Document Manager, it 
must be a valid user created in the IStream Document Manager.

RDBMS
If proxy users generate from model documents that require database access, 
ensure that the proxy user is set up as a database user.

IStream Document Manager
1. Log in to IStream Document Manager as the Administrator.
2. Set up a list of users for each group, adding groups as necessary.
3. Go to the permissions for each Assembly Server you are using and set up 

proxy users for each group.
4. Ensure these proxy users are set up as database users on the RDBMS. The 

group proxy user can be overridden for specific users.
5. Navigate to each folder and assign any specific user permissions such as 

add, delete and modify, on a group or user level.

Note: Refer to the IStream Document Manager Technical Guide for additional 
information on configuring your deployment.
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Troubleshooting the Add-In

This section describes:

• the steps you can take if the Add-In does not appear 

• issues you may encounter if you are using Microsoft Word 2007

Add-In Does Not Appear
This section describes steps you can take if the Add-In does not appear. Complete 
each procedure in the order it appears.

Exit and Reopen Microsoft Word
• Completely exit Microsoft Word, then open it again. If the Add-In still fails 

to load, continue to the next step.

Check Office Security Settings
1. In Microsoft Word, select Tools > Macro > Security.
2. If you are using Word 2003, ensure that the Security Level is not set to Very 

High.
3. Restart your computer.
4. Open Microsoft Word again. If the Add-In still fails to load, continue to the 

next step.

Check the Add-In Directory Access
Ensure that the user has “read” access to the Add-In application directory. If the 
Add-In still fails to load, continue to the next step

Check the Word Startup Switch
If Word is launched using the /a startup switch, then the Add-In will not start.

After removing the switch, open Microsoft Word again. If the Add-In still fails to 
load, continue to the next step.

Check the Add-In Registry Setting
1. In the Windows Registry, navigate to the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\Word\
Addins\AuthorAddIn.Connect

2. Ensure that the value for LoadBehavior is 3:
"LoadBehavior"=dword:00000003

Open Microsoft Word again. If the Add-In still fails to load, continue to the 
next step.
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Uninstall and Reinstall the Add-In
Uninstall then reinstall the Add-In.

If the add-in still fails to load, continue to the next and final step.

Back Up Log File and Contact Customer Support
1. Back up your last current log file.
2. Contact Customer Support: see Contacting Oracle for Help on page 18.

Working with Microsoft Word 2007
This section describes how to resolve issues you may encounter if you are using 
Microsoft Word 2007.

IStream Add-In Initialization Error 
If you are using Microsoft Word 2007 under Microsoft Windows XP and you 
receive an IStream Add-In initialization failed error, then ensure you have enabled 
.NET Programmability. To do this, select:

Control Panel > Add/Remove Programs > Microsoft Office 2007 > Add or 
Remove Features > Installation Options > Microsoft Office Word > .NET 
Programmability Support. 

Security Warning

In Microsoft Word 2007, in the Add-Ins section of the Trust Center, if the 
checkbox for Require Application Add-ins to be signed by Trusted Publisher 
is selected, a security warning may appear when opening Microsoft Word. If so, 
click Options, then select Enable all code published by this publisher. 
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Appendix A
Adding/Removing Components

& Uninstalling

This appendix describes:

• Adding or Removing Components on page 64

• Uninstalling IStream Document Manager on page 65



ADDING OR REMOVING COMPONENTS

64 ISTREAM DOCUMENT MANAGER VERSION 6.2 GUIDE FOR NEW INSTALLATIONS

Adding or Removing Components

You can to add or remove specific IStream Document Manager components from 
your system. To completely uninstall IStream Document Manager, see 
Uninstalling IStream Document Manager on page 65.

Method: Add or remove IStream Document Manager components

1. From the Control Panel, select Add/Remove Programs > IStream 
Document Manager.

2. Click Change/Remove.
3. The InstallShield Wizard dialog box briefly appears.
4. Click Modify, then Next.
5. On the Select Features screen, select the cleared features you want to install 

or clear the selected features you want to uninstall.

The system will install the selected features, and remove the cleared 
features.

When the process is complete, the Maintenance Complete summary screen 
is displayed.

6. Click Finish to exit.
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Uninstalling IStream Document Manager

This procedure describes how to completely uninstall IStream Document 
Manager. To add or remove specific components from your system, see Adding or 
Removing Components on page 64.

Method: Uninstall IStream Document Manager

1. From the Control Panel, select Add/Remove Programs > IStream 
Document Manager.

2. Click Change/Remove.
3. The InstallShield Wizard dialog box briefly appears.
4. Click Remove, then click OK when prompted.

• all files in install_folder\3rd Party Components\ 
tomcat\webapps\calligo\conf\

and the following file
install_folder\3rd Party Components\tomcat\ 
config\server.xml

will be backed up to:
install_folder\3rd Party Components\tomcat_bak\

5. In all cases,install_folder is the full path of your IStream Document 
Manager installation.

6. Note that the following registry keys are not removed because they belong 
to third-party applications:
• HKEY_CURRENT_USER\Software\iTech Software

• HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software 
Foundation

• HKEY_LOCAL_MACHINE\SOFTWARE\iTech Software

• HKEY_LOCAL_MACHINE\SOFTWARE\SCC

• HKEY_CLASSES_ROOT\ITLogbook.Document

• HKEY_CLASSES_ROOT\ITLogServerCom.Application

• HKEY_CLASSES_ROOT\ITLogServerCom.Application.1

• HKEY_USERS\.DEFAULT\Software\SCC

Method: Uninstall the IStream Document Manager module

1. Login to the Livelink Administration page:
http://server_name/service_name/livelink.exe?func= 
admin.index
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2. Select Uninstall Modules > Calligo 6.2 > Uninstall.
3. When prompted, restart the Livelink Server.
4. Delete the following subfolder:

Opentext_install_folder/staging/calligo_6_2_0

After you restart your system, this service will no longer appear.
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